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Overview

A formula uses numeric and variable values (e.g., select lists, numeric or date fields, or workflow
states) to generate Incident Severity, Estimated Damage, or Incident Likelihood. Formulas are
added to an object type through a Relationship or Reference.

A formula appears on a form as a number, label (e.g., Low, Medium, High), numbers and labels,
gauge, or as a formula card.

Related Information/Setup

For more information on formulas, see the following articles:

e Formulas Overview

¢ Variables, Operators & Functions
¢ Time Functions

¢ Null Values in Formulas

e Formula Examples

e Formulas on Forms

Navigation
1. From the Home screen, click the Administration icon.
® Qe [elo =
Home v My Tasks
My Tasks 4 SORT Q SEARCH ([ TASKS SUMMARY Recently Viewed

[ Asset needs fixing
Viewed 6 days ago at 1138 AM

= Insufficient control consciousness
fevied 6 days ago at 11:35 AM

o7 Talent retention
Viewed 11 days ago at 311 PM

[ ] — 1 RM - Summary of Issues by Business Unit
Viewed 11 days ago at :11 PM
Corrective Action @ lssue LossEvent @ Risk

RR-1 RM - Library Risk and Control Matrix

Viewed 11 days ago at 310 PM
LE36  Accounting Error :
Aseigned to me on Dec 10th, 2024

LE-36 Accounting Error

Viewed 13 days ago st 422 PM
€2 Action Plan 002
Assigned to me on Dec 10th, 2024

Administration Icon

2. From the Administrator settings menu, click Admin Overview.


http://help.resolver.com/help/select-list
http://help.resolver.com/help/numeric
http://help.resolver.com/help/date-time
http://help.resolver.com/help/workflow-overview
http://help.resolver.com/5852b5c332131cad474c0a01/language/en/version//help/add-relationships
http://help.resolver.com/5852b5c332131cad474c0a01/language/en/version//help/references-form
http://help.resolver.com/help/formulas-overview
http://help.resolver.com/help/operators-functions-functions
http://help.resolver.com/help/time-functions
http://help.resolver.com/help/null-values
http://help.resolver.com/help/formula-examples
http://help.resolver.com/help/formulas
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@ (Qsearch &8 0 2
Home v My Tasks
Settings
My Tasks

$ SORT Q SEARCH 8o User Management

@ Branding

@3 Languages

Administrator Settings Menu

3. From the Admin Overview screen, click the Object Types tile under the Data Model
section.

802
Admin Overview v

Data Model Views

Object Types

Configurable Forms
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Dashboard Data
Fields Assessments Data Definitions Sets Dashboard Builder

Playbooks Automation

Data Access Application Management

S B 8

oo

Dashboard
User Groups Roles. Org Manager Applications Deployment

Object Types Tile

4. From the Object Types screen, from the list of object types, click the object type that you
want to add a formula to.

@ (Qseann

8O 2
a
Data Model v Object Types Object Type Groups Fields Assessment ts. Data Definition Playbook Automation

Admin: Object Types

l ° Activity |
@ Activity Type

A Alert

Alerts inform compliance teams when new or proposed regulatory changes are

Object Types Screen

Adding a Formula to an Object Type

1. From the Edit Object Type screen, click the Formulas tab.
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@ (Qserch P

Data Model v Obiject Types Object Type Groups. Fields. Assessment ts Data Definition
Admin: Edit Object Type
Activity ’

Workflow Concatenations

Workflow

Summary information about the Object Type: related forms, object type groups, activities / applications, Reports, report definitions.

Related Forms

Activity - CC - Create Priorty: none

Formulas Tab

2. From the Formulas tab, click on the Add Formula button.

c e o
® (Qsearch S0 &
Data Model v Object Types. Object Type Groups. Fields Assessment ts Data Definition

Overview Fields (18) Formulas (9) Relationships (16) References (1) Roles (1)

+ ADD FORMULA

Al of the formulas that have been built Activity.

Activity DowW [0}
- oro: : 20wl enderwith 3 Label

Activity ToD [0}

3 Fomu €0, oTo: 28) it e it 3 Label

Count [0}
rula COUNT wil render with a None

Earliest Response Time @

i timeDiff{ARRIVEDDAT, ASSIGNEDDA, "minutes") wil rerder with 2 None

Add Formula Button

3. From the Create New Formula pop-up, enter a formula name in the Name field (e.qg.,

Estimated Vehicle Damage) and click the Create button.

Create New Formula

*Name

New Formu|

CANCEL v CREATE

Create New Formula Pop-Up

4. In the Formulas tab, click the new formula to open the Edit Formula pop-up.
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& CONFIGURE WORKFLOW

@ (Qsearch IO
Data Model ©  ObetTypes  ObjectTypeGroups  Ficlds  Assessments  Data Defintion
e EDIT FORMULA x
‘Workflow Concatenations
DETALS
Workflow *Name

New Formula

Description
Overview Fields (18) Formulas (10) Relationships (16) Referen
4
All of the formulas that have been built Activity. VARIABLES
Activity DowW
3 R 1£0_DT; 71 wil render with  Label
Activity ToD
I F i IED_DTO ),24) vill ender with a Label
FORMULA
Count

5. (Optional): Enter a description documenting the formula's internal use in the Description
field.

Edit Formula Pop-up

arch. o
® (Qseara (G ION-Y
Data Model v Object Types Object Type Groups. Fields. Assessment ts Data Definition
e EDIT FORMULA x
Workflow Concatenations
DETALS
Workflow *Name
New Formula
Description
Overview Fields (18) Formulas (10) Relationships (16) Referen
All of the formulas that have been built Activity. VARIABLES
Activity Dow
3 Form ) DT.0.hour ender with  Label
Activity ToD
N eo_oro: 200 il e it s Lol
FORMULA
Count

Description Field

6. From the Variables section, click the Add Variable button. A variable is a value in which

the formula calculations are performed.
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@ (Qsearch 8O 2
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
. . . EDIT FORMULA x
Admin: Edit Object Type
VaRIABLES
Activity
FoRMULA
‘Workflow Concatenations
INSERT VARIABLE "
Workflow

£ CONFIGURE WORKFLOW. SAVE FORMULA RECALCULATE AND REFORMAT

e DISPLAY
Overview Fields (18) Formulas (10) Relationships (16) Referencl
Format
None v
All of the formulas that have been built Activity. .
Display as
Activity DowW
None v
3 Formula IED_DT0; 44)7) il ender with a Label

Add Variable Button

7. From the Variables section, select one of the following types from the Variable Type

drop-down list:

¢ Field: After selecting the Field variable, the following field will appear:
o Available Components: Select a field or formula from the Available

Components drop-down field adding it directly to the object type.

Note:
@ Fields can be added to formulas after they are added to an object type or if they are
associated through a relationship or reference. Only numeric fields, date fields, and
select lists with numeric values are accepted. For more information, see the Fields article.

@ (Q search.. 000 S @ Q
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
Overview | Fields (3) Formulas (14) Relationships (1) [RSRLLILASISETITCY X
VARIABLES
All of the formulas that have been buitt Account. * Variable Type * Available Components
% Insured Gap Field
¥ Formula -(CDV-RCN)/CDV will render with a Label and Result
#Name
% Over Insured
3 Formula -VAL will render with a None
% Under Insured -
_ ) Description
3 Formula (CDV-RCN)CDV will render with 2 None

Amount Under Insured
3 Formula CDV-RCN will render with 2 None
Treat empty values as Null

Estimated Vehicle Damage

3 Formula will render with 3 None

CANCEL
Highest Single Calculated RCN Value

3 Formula MAXRCN will render with @ None

Field Variable Type

¢ Relationship: After selecting the Relationship variable, the following fields will

appear:


http://help.resolver.com/help/fields
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o Relationship: Select the object type relationship from the Relationship drop-

down list. Relationships connect two or more objects. The user must add a
relationship to an object type to appear on the Relationship drop-down list.
See the Add Relationships to an Object Type article for further information on
adding a relationship to an object type.
Available Components: Select a field or formula from the Available
Components drop-down field adding it directly to the object type.
Sub Type: Select a sub type from the Sub Type drop-down list. Sub types
specify how the data from multiple objects are compiled, calculated, and
displayed. For more information on sub types, see the sub type table in the
Variables, Operations, & Functions article.
= Array: Creates a set of values from the variable.
= Sum: Calculates a total from the variable's set of values and returns a
single number. Select list variables cannot use sum sub types.
= Count: The number of times a variable has been added to an object.
= Average: Calculates an average number from the variable's set of
values. Select list variables cannot use average sub types.
= Every: Checks if the variable contains a value on the objects in the
relationship/reference.
= Min: Calculates the lowest number from the variable's set of values.
Select list variables cannot use min sub types.
= Max: Calculates the highest number from the variable's set of values.

Select list variables cannot use max sub types.

Data Model

Overview Fields (3) Formulas (14) Relationships (1) JREILIASLILUINCY X

@® (Q search

Object Type Groups

848

v Object Types Fields Assessments Data Definition

VARIABLES

All of the formulas that have been built Account *Variable Type *Relationship

% Insured Gap
§ Formulz -(CDV-RCN)/CDV will rende

Relationship
ith 2 Label and Result
Available Comy
% Over Insured

I Formuia -VAL will render with a None

% Under Insured Sub Type
¥ Formula (CDV-RCN)CDV will render with a None
Amount Under Insured

3 Formula COV-RCN will render with a None * Name
Estimated Vehicle Damage
& Formuia will render with a None
Description
Highest Single Calculated RCN Value
3 Formula MAXRCN will render with a None

Highest Single Customer Declared Value
3 Formula MAXCDV will render with a None

Treat empty values as Null

Lowest Single Calculated RCN Value CANCEL

Formula MINRCN will render with a None

Number of Locations

Relationship Variable Type

e Reference: After selecting the Reference variable, the following fields will appear:


https://help.resolver.com/help/add-relationships
https://help.resolver.com/help/operators-functions-functions
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o Reference: Select the object type reference from the Reference drop-down

list. References indicate that an object is connected to another object through a

relationship. References are automatically created when a relationship is

created. For further information on adding a relationship to an object type, see

the Add References to an Object Type article.

o Available Components: Select a field or formula from the Available

Components drop-down field adding it directly to the object type.

o Sub Type: Select a sub type from the Sub Type drop-down list. Subtypes

specify how the data from multiple objects are compiled, calculated, and

displayed.
Data Model v Object Types
EDIT FORMULA X
VARIABLES in
All of the formulas that have been built Activity.

ACTCOUNT Variable Type Reference

ACT Nene

Reference

Activity DowW

mod({{{{timediff(SUPPLIED_DT.0."hours")+ TimeZone ik d
Activity ToD

mod({{timediff(SUPPLIED_DT,0,"hours") +TimeZonel

Count

COUNT Nane

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA."minutes”)

Estimated Vehicle Damage

None

Linked Incident Count

IncExists Label

On Site Time

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi

Name

Description

Treat empty values as Null

CANCEL

Reference Variable Type

¢ Property: After selecting the Property variable, the following field will appear:

o Property: Select a property type from the Property drop-down list:

s |Is Submitter Confidential: This property type creates a formula that

compares the number of confidential submissions against the number of

not confidential submissions for customers that use the

Confidential Reporting Portal.


https://help.resolver.com/help/references
http://help.resolver.com/#Subtype
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@ (Q search ooo @ @ Q
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
O Fields (3) Formulas (14) RISt EDIT FORMULA x
VARIABLES
All of the formulas that have been buitt Account. * Variable Type * Property
% Insured Gap Property
¥ Formula -(CDV-RCN)/CDV will render with a Label and Result
#Name
% Over Insured
§ Formula -VAL will render with a None
% Under Insured .
~ Description
3 Formula (CDV-RCNNCDV will render with 2 None
Amount Under Insured
3 Formula CDV-RCN will render with 2 None
Treat empty values as Null

Estimated Vehicle Damage
% Formula will render with a None CANCEL

Highest Single Calculated RCN Value

3 Formula MAXRCN wil render with = None

Property Variable Type

8. The system will automatically populate the Name field with the field or formula's unique ID
by default.

9. (Optional): Enter a variable name in the Name field.

Warning:
A Using a function name (Sub Type Name) in the name field will cause an error.

@ Q Search. ooo @ @ 2

Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition
T} Formuia (COV-RCNCDV will render with 2 None -
EDIT FORMULA X
Amount Under Insured
§ Formula CDV-RCN will render with 3 None -
Highest Single Calculated RCN Value VARIABLES

3 Formula MAXRCN wil render with = None

Highest Single Customer Declared Value #Variable Type * Available Components
1 Formuia MAXCDV will render with a None
Field Number of Locations

Lowest Single Calculated RCN Value

3 Farmula MINRCN will render with s None * Name

Number of Locations NUMBEROFLOCATIONS

5 Formula loc will render with a None

Description

Number of Projects

3 Formula pro will render with a None

Number of Properties
3 Formula will render with s None Treat empty values as Null

Number of Valuations CANCEL
§ Formula Val will render with a None.

Total Client Declared Value - Buildings
1 Formuia SUMCDYV will render with a None

Variable Name

10. (Optional): Enter a variable description in the Description field.

11. (Optional): Select the Treat empty values as Null checkbox to exclude blank objects
from a formula calculation. For more information, see the Null Values in Formulas article.

12. Click the Create button to add the variable. The system will perform the Syntax Validation
function, and an error message will appear under the Formula field, reminding the user to

add the variable name to the Formula field.


http://help.resolver.com/help/null-values
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@ (Qsearch. oo B0
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
§ Formula -VAL will render with a None EDIT FORM X
% Under Insured -
3 Formula (COV-RCNMCDV will s Description
Amount Under Insured
i Formula CDV-RCN will res vith 3 None
Highest Single Calculated RCN Value LB A T eaL
§ Formula MAXRCN will render with a None
CANCEL
Highest Single Customer Declared Value
3 Formula MAXCDV wil r with a None
. NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formuls Number of Locations  Treat empty v null False
§ Formulz MINRCN will render with a None
Number of Locations
& Formuia lec will render with a None FORMULA
Number of Projects
3 Formula pro will render with a None S ERT RO P
- <
Number of Properties _ .
5 Formula will render with a None e v
“ »
Number of Valuations 3
N Error: Please remove numberoflocations or add them to the formula.
§ Formula Val will render with a None
Total Client Declared Value - Buildings e
1 Formuia SUMCDYV will render with a None
Total Replacement Cost Amount - Buildings .

Variable Error Message

13. Click the Insert Variable button and select a variable from the drop-down menu. The

selected variable will be added to the Formula field.

@ (Q search.. ooo @ @ Q
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
rvover mauey —
% Formula -VAL will render with a None EDIT FORM X
% Under Insured -
§ Formulz (CDV-RCN)CDV will render wit Description
Amount Under Insured
i Formula CDV-RCN will res 2 None
Highest Single Calculated RCN Value LB A T eaL
§ Formula MAXRCN will render with a None
CANCEL
Highest Single Customer Declared Value
1 Formula MAXCDV will render with a None
. NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formula: Number of Locations  Treat empty values as nulk false
3 Formula MINRCN will render with a None
Number of Locations
1 Formuia lec will render with a None FORMULA
Number of Projects
¥ Formula pro will render with a None S ER L EOGE P
- <
Number of Properties NUMBEROFLOCATIONS .
& Formuia will render with a None v
T »
Number of Valuations 5
N Error: Please remove numberoflocations or add them to the formula.
3 Formula Val will render with a None:
Total Client Declared Value - Buildings SAVEECRESIS
§ Formula SUMCDV will render with a None
Total Replacement Cost Amount - Buildings .

Insert Variable Button

14. Click the Save Formula button. The Formula field will indicate if the formula syntax is
correct. If the formula syntax is correct the formula will be saved.

o Click the Expand icon on the Formula field to open the expandable screen mode.
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® (Q search 000 B @ N
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
§ Formula -VAL will render with a None EDIT FORMULA x
% Under Insured -

3 Formuia (CDV-RCNNEDV will render with 2 None Description

Amount Under Insured
& Formula CDV-RCN will render with a None

Highest Single Calculated RCN Value LB A T eaL
§ Formula MAXRCN will render with a None
CANCEL

Highest Single Customer Declared Value
1 Formula MAXCDV will render with a None

. NUMBEROFLOCATIONS x
Lowest Single Calculated RCN Value Formula: Number of Locations ~ Treat empty values as null: false
§ Formulz MINRCN will render with a None
Number of Locations
& Formuia lec will render with a None FORMULA
Number of Projects
3 Formula pro will render with a None SERTTOTE o -
Number of Properties
3 Formula NUMBEROFLOCATIONS will render with a None NUMBEROFLOCATIONS®

“ »

Number of Valuations
s e Formula syntax is correct. Formula saved.
Total Client Declared Value - Buildings e V% RECALCULATE AND REFORMAT

3 Formula SUMCDV will render with a Nene

Total Replacement Cost Amount - Buildings

Formula Syntax

Click the Delete icon next to the variable to delete the variable.

848

Data Model ~ Object Types
EDIT FORMULA X
All of the formulas that have been built Activity. VARIABLES
ACTCOUNT
Variable Type
ACT None
. Select one...
Activity Dow
mod{{{{timediff(SUPPLIED_DT,0,"hours")+ TimeZone Name
Activity ToD
mod({{timediff(SUPPLIED_DT.0,"hours")+TimeZonel
Description
Count
COUNT None

g 2 Treat empty values as Null
Earliest Response Time

timeDiff{ARRIVEDDAT, ASSIGNEDDA "minutes”) CANCEL

Estimated Vehicle Damage
REPORTEDDA iaa REPORTEDDA E

Linked Incident Count

IncExists Label

Delete Icon

From the Formula section, enter a formula using the variable name(s) you entered in the
Name field in the Variables section. Include operators and functions in the Formula field
(e.g., INCIDENTSE==3). For more information on operators, see the operators table in the
Variables, Operators, & Functions article.

A system notification will appear under the Formula field, indicating that Your formula is
not saved.

The Recalculate and Reformat button will be greyed out, preventing invalid formulas

from being sent to the processing queue and causing a potential slowdown.


https://help.resolver.com/help/operators-functions-functions
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@ Q, Search_ o000 @ @ g -

Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition

Internal Audit Project - Control Workilow ;
EDIT FORMULA X
Control Self-Assessment Waorkflow (Risk & Compl

-

Control Status FORMULA

IT Compliance Assessment Control Workflow

INSERT VARIABLE ~ o
Internal Controls Assessment - Control Workflow ‘

SUM(COUNT
4 »

Compliance Testing Workflow (Prototype)

IT Risk Assessment Control Workflow Your formula is not saved

SAVE FORMULA

Concatenations

# CONFIGURE NAME CONCATENATION ERSET
## CONFIGURE DESCRIPTION CONCATENATION
Format Range as
None > None
Qverview Fields (46) Formulas (11) Relatiol

£ REFORMAT

System Notification - Your Formula is Not Saved

19. Click the Save Formula button.

Warning:
A The Autosave function was removed from the Edit Formula pop-up. Changes to the
Formula field require a user to click the Save Formula button.

Changes not manually saved will be discarded, and the system will revert to the
previously saved state.

The system will perform a Syntax Validation on the formula to confirm if the formula is:

¢ Valid: A system notification will appear under the Formula field; Formula syntax is

correct. Formula saved. The Recalculate and Reformat button will be active.
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@ Q, Search_ o000 @ @ g -

Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition

Internal Audit Project - Control Workilow ;
EDIT FORMULA X
Control Self-Assessment Waorkflow (Risk & Compl

-

Control Status

FORMULA
IT Compliance Assessment Control Workflow
Internal Controls Assessment - Control Workflow [NSERTVARIASLE > o
Compliance Testing Workflow (Prototype) ‘SUM(COUNU‘ R =

IT Risk Assessment Cantrol Workflow Formula syntax is correct. Formula saved.

SAVE FORMULA V¥ RECALCULATE AND REFORMAT
Concatenations
# CONFIGURE NAME CONCATENATION ERSET
## CONFIGURE DESCRIPTION CONCATENATION

Format Range as
None > None
Qverview Fields (46) Formulas (11) Relatiol
2 REFORMAT

System Notification - Valid Formula

¢ Invalid: A system notification will appear under the Formula field; Error Syntax
error in part (char 1). The formula is not saved. The error will indicate the
character (char) location of the error in the formula and that the formula is invalid and
not saved. The Recalculate and Reformat button will be greyed out, preventing

invalid formulas from being sent to the processing queue and causing a potential

slowdown.
@ Q, Search_ o000 @ @ g -
Data Model ~ Object Types Object Type Groups Fields Assessments Data Definition
" Internal Audit Project - Control Workilow .
EDIT FORMULA X
Control Self-Assessment Waorkflow (Risk & Compl
Control Status FORMULA

IT Compliance Assessment Control Workflow

INSERT VARIABLE e
Internal Controls Assessment - Control Workflow
sumM(counT| :
Compliance Testing Workflow (Prototype) q D
IT Risk Assessment Control Workflow Error: Parenthesis ) expected (char 10).

Your formula is not saved

A SAVE FORMULA

Concatenations
## CONFIGURE NAME CONCATENATION

DISPLAY
## CONFIGURE DESCRIPTION CONCATENATION

Format Range as

Overview Fields (46) Formulas (11) Relatiol None None
2 REFORMAT
-

System Notification - Invalid Formula

20. (Optional): Click the Recalculate and Reformat button to recalculate all the formulas in

your Org.
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21. In the Display section, select a format from the Format drop-down list:

¢ None: Uses no display formats.

Data Model ~ Object Types
EDIT FORMULA X
VARIABLES i
All of the formulas that have been built Activity.
i
+ ADD VARIABLE
ACT Neone
- REPORTEDDA ®

Activity Dow

mod({{{{timeditf(SUPPLIED_OT.0 "hours")+ TimeZone
Activity ToD

mod{{{timediff(SUPPLIED_DT.0,"hours"} +TimeZonel FORMULA;
Count REPORTEDDA

COUNT Mone

Formula syntax is correct. Formula saved.
Earliest Response Time

imeDiff(ARRIVEDDAT, ASSIGNEDDA, "minutes”) EE KB E DL V¥ RECALCULATE AND REFORMAT
Estimate Vehicle Damage
REPORTEDDA None
DISPLAY
Linked Incident Count
IncExists Label Format Range as
On Site Time None None ~
timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi
o & REFORMAT
Priority =
PRIORITY Label
= o & o

Format = None

e Numeric: Allows the user to choose how the numbers will be displayed using the
options on the table.

o Num: Displays numbers in numeric format.

o %: Displays numbers using percentage format.

o Cur: Displays numbers using currency format. Currency fields will be formatted

as follows:
= $ AUD

$ CAD
$ HKD
$ NzZD
$ USD
£ GBP
€ EUR
F CHF
¥ CNY
¥ JPY

The format of the currency value will automatically change based on the

currency selected:
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Currency Type Currency Value Format
$ AUD, $ CAD, $ HKD, $ NZD, $ USD $ 1,234.56
£ GBP £ 1,234.56
€ EUR 1.234,56 €
F CHF 1.234,56 F
¥ CNY, ¥ JPY ¥ 1,234.56

o 0.00: Displays numbers using decimal format.

o Layout: Previews the number format selected.

® (Q searen & °
Data Model v Object Types Object Type Groups Fields Assessments Data Definition
EDIT FORMULA X
Overview Fields (46) Formulas (11) Relatiol
FORMULA -
INSERT VARIABLE ~ s
All of the formulas that have been built Control.
# of Related Citations SUM(COUNT) M
§ Formula COUNT will render with a Result J C
Formula syntax is correct. Formula saved.

% of Samples Failed

3 Formula (FAILED/TESTED) will render with 3 Label and Result

SAVE FORMULA VX RECALCULATE AND REFORMAT
9% of Samples Tested
3§ Formula (TESTED/TOTAL) will render with a Label and Result
Control Self-Assessment
. DISPLAY
2 Formula CONTROLSELF will render with a Label
Design Effectiveness
9 Format Layout Range as
1 Formula DESIGNEFF will render with a Label
o Num| %| $| 0.00]
Numer > G = None ™
DNU Num| %] -§[-0.00)
Formula will render with a None
C REFORMAT
Net Loss
§ Formula NETLOSS will render with a None
v
N1 I £ |

Format = Numeric

e Range as:
o None: The formula will display the numeric results only.
o Label: The formula will display the range labels only (e.g., Low, Medium, High)
in the color selected for that range.
o Label and Result: The formula will display the numeric results and labels (e.qg.,
Low - 1000) in the color selected for that range.
o Result: The formula will display the numeric results only in the color selected

for that range.

22. If a user selects Label, Label and Results, or Results from the Range as drop-down list,

the system will automatically add three default formula labels Low, Medium, and High.
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Data Model ~ Object Types.
EDIT FORM
All of the formulas that have been built Activity. REFORTEDDA
ACTCOUNT Formula syntax is correct. Formula saved.
ACT None
SAVE FORMULA '\[; RECALCULATE AND REFORMAT
Activity Dow
modi({{{timediff(SUPPLIED_DT,0,"hours")+ TimeZone
Activity ToD DISPLAY
mod({{timediff(SUPPLIED_DT.0,"hours")+TimeZonel
Format Layout Range as
Count ) [Num| %] §[ 0.00
COUNT None plamEdics ° -Num| -%| -$/-0.00 Labelane
Earliest Response Time o REFORMAT

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") v

Estimate Vehicle Damage @ v P |
REPORTEDDA Label and Result - 33

Linked Incident Count Medium ‘ i}
IncExists Label 33 66

On Site Time @ ron @
1imeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 68; 100

Priority
PRIORITY Label
X il i i

Formula Labels

23. Click the Edit icon next to the Formula Label you want to edit.

Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. RERORTEDD
ACTCOUNT Formula syntax is correct. Formula saved.
ACT None
SAVE FORMULA VX RECALCULATE AND REFORMAT
Activity Dow
mod{{{{timediff(SUPPLIED_DT,0,"hours")+ TimeZone
Activity ToD DISPLAY
mod({(timediff(SUPPLIED_DT.0,"hours")+TimeZonel
Format Layout Range as
Count ) [Num] %[  $[ 000
COUNT None i plamenc ° -Num| -%| -$/-0.00 Lahelant
Earliest Response Time 2 REFORMAT

timeDiff(ARRIVEDDAT. ASSIGNEDDA "minutes”) v/

Estimate Vehicle Damage . Low D i

REPORTEDDA Label and Result 7.33
Linked Incident Count Medium o
IncExists Label 33 56
On Site Time @ ron i}
66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

Priority

PRIORITY Label

& o e

Edit Icon

24. The Formula Label fields will appear, allowing the user to edit the field values:
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e Color: Click the Color drop-down to reveal the color picker and select a new color for
the label. You can also type a hex color into this field to select a color.

e Label: Enter a new name for the label in the Label field.

¢ Max Value: Enter a maximum value in the Max Value field, creating a numeric value

range for the Formula Label.

8 0Ea

Data Model ~ Object Types
EDIT FORMULA X
All of the farmulas that have been built Activity. Fermula syntax is correct. Formula saved.
ACTCOUNT 7
SAVE FORMULA * RECALCULATE AND REFORMAT
ACT Nene
Activity Dow
mod({{{timediff(SUPPLIED_DT,0."hours")+ TimeZone DISPLAY
Activity ToD
mod({{timediff(SUPPLIED_DT 0, "hours")+TimeZonel Format Layout Range as
) Num| % $| 0.00]
Count Numeric 0 Num| %| § 000 Label ant
COUNT Mone

£ REFORMAT

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA."minutes™) i
Color Label Max Value

Estimate Vehicle Damage . 2003591 Lo 33
REPORTEDDA Label and Result

Linked Incident Count Medium o
IncExists Label e 56

On Site Time @ o a

66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mj

L ADD LABEL
Pricrty

PRIORITY Label

= o & i)

Formula Label Fields

25. Click the Save icon to save your changes.
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Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT s
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{{timedif(SUPPLIED_DT.0,"hours"} +TimeZone DISPLAY
Activity ToD
mod{{[timedit{(SUPPLIED_DT.0,"hours")+ TimeZonel Format Layout Range as
Num| % $| 0.00]
Count Numeri¢” o] Nam| -%| -s|-0.00 Label an
COUNT None

Z REFORMAT

Earliest Response Time

timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") m
Color Label Max Value

Estimate Vehicle Damage . #00a591 e 33
REPORTEDDA Label and Result

Linked Incident Count Madiim L}
IncExists Label 33 66

On Site Time . High o

66 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

Priority
PRIORITY Label
X il i bt

Save Icon

26. Click the Delete icon to delete a Formula Label.

Data Model ~ Object Types
EDIT FORMU
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT bR
SAVE FORMULA % RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{{timedif(SUPPLIED_DT,0,"hours"} +TimeZone DISPLAY
Activity ToD
mod({{timediff(SUPPLIED_DT,0,"hours") +TimeZonel Format Layout Range as
R Num| % $| 0.00]
Count Numerie 0 Nam| -%| -5|-0.00 Label an
COUNT None

Z REFORMAT
Earliest Response Time

timeDiff(ARRIVEDDAT. ASSIGNEDDA "minutes”)

Color Label Max Value
Estimate Vehicle Damage . #00a591 L 33
REPORTEDDA Label and Result
Linked Incident Count Mediim L1}
IncExists Label 33 66
On Site Time . High o
1timeDIff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 66 100
Priority
PRIORITY Label
= c 4 =

Delete Icon

27. Click Add Label button to add a new label.
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Data Model Object Types.

EDIT FOR! X

All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.

ACTCOUNT B
SAVE FORMULA * RECALCULATE AND REFORMAT
ACT None
Activity Dow
mod({{ (timediff(SUPPLIED_DT,0, "hours") + TimeZone DISPLAY
Activity ToD
mod{{[timedit{(SUPPLIED_DT.0,"hours")+ TimeZonel Format Layout Range as
Num % $| 0.00
Count Numeri¢” o] Nam| -%| -s|-0.00 Label an
COUNT None
< REFORMAT
Earliest Response Time
timeDiff(ARRIVEDDAT, ASSIGNEDDA "minutes") m
Color Label Max Value
Estimate Vehicle Damage . #00a591 e 33
REPORTEDDA Label and Result
Linked Incident Count Madiim L}
IncExists Label 33 66
On Site Time . High o
656 100

timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"m|

Priority
PRIORITY Label
X il i g E

Add Label Button

28. If changes are made to the Formula Label on the Display section, you must click the

Reformat button before the changes are displayed.

Data Model ~ Object Types
EDIT FOR X
All of the formulas that have been built Activity. Formula syntax is correct. Formula saved.
ACTCOUNT T
SAVE FORMULA * RECALCULATE AND REFORMAT
ACT None
Activity DowW
mod(({(timediff(SUPPLIED_DT.0,"hours")+ TimeZone DISPLAY
Activity ToD
mod({{timediff{SUPPLIED_DT.0,"hours") + TimeZonel Format Layout Range as
Num| % $| 0.00
Count Numerie 0 Num| -%|  -§/-0.00 Label ant
COUNT None
i REFORMAT
Earliest Response Time
timeDiff(ARRIVEDDAT, ASSIGNEDDA,"minutes”) il
Color Label Max Value
Estimate Vehicle Damage . #003591 Lo 33
REPORTEDDA Label and Result
Linked Incident Count Meditim L
IncExists Label =5, Gz
On Site Time @ - o
timeDiff(MAXCLEAREDDATE, MINARRIVEDDAT,"mi 66 200
Priority
PRIORITY Label
b uH = i g

Reformat Button



